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The Pre-Production Process

Making Use of The Design Lab

The Design Lab has a pair of high quality monitors (small speakers), and an audio interface that
connects these to your computer. The audio interface can also be used to connect microphones or
instruments to the computer for recording.

The monitors and interface are stored in the rolling cart at the front of the Design Lab.

To use these monitors and interface:

* Connect the Focusrite Scarlett to your computer using the USB cable provided.
Place the monitors in position to the left and right of your computer.
Plug each monitor into a power strip using the cables provided.
Connect the left loudspeaker to the left output on the rear of the Focusrite Scarlett and the
right loudspeaker to the right output, using the cables provided.
Turn on each loudspeaker using its power switch.
In your audio software of choice, select Focusrite Scarlett as your audio device in
preferences (or, go to System Preferences / Sound, and select it in the Output and Input
tabs).
Please strike everything when you 're done using it, and return it to its storage location at
the front of the Design Lab.

Using the Department’s Sound Effects Library
The Department of Theatre & Dance has access to a large number of high quality sound effects,
which can be accessed with the help of Prof. Eckelman.

You can also find many reasonable sound effects at freesound.org, or purchase other sound effect
collections from within the show’s budget. Please coordinate with Prof. Eckelman.

Using REAPER to edit and record audio
Every computer in the design lab has a powerful but relatively simple Digital Audio Workstation
called REAPER, which allows you to edit and record audio.

* A REAPER user guide is available at reaper.fm/userguide.php
Additional videos and other resources are available at reaper.fm, and a google search will
turn up answers to many of your questions.
Prof. Eckelman can answer additional questions you have about REAPER
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Understanding the Rep Sound System in Tawes Theatre

Complete documentation of the Rep Sound System can be found on the Department of Theatre &
Dance’s website, under Productions / Production Information, or in the Appendix at the end of
this guide.

The Rep system provides basic coverage of the audience from two pairs of main loudspeakers —
an Upstage Left and Right pair, and a Downstage Left and Right Pair. Note that the Downstage
pair of loudspeakers does not cover the entire audience evenly (specifically, the left and right
seating sections are out of coverage of these loudspeakers).

In addition, the Rep system includes a pair of subwoofers.

Rep speakers may not be moved, refocused, or re-patched under any circumstances.

Work with your director to decide on the placement of any additional loudspeakers that may be
needed to bring your design to life. The Rep System allows for up to 2 additional loudspeakers to
be added on a show-by-show basis.

Loudspeaker QLab Position Notes
# Channel #
1 1 Upstage Right “Main Left”
2 2 Upstage Left "Main Right”
3 3 Downstage Right (Sound may be compromised in high

frequency for some audience members)

(Sound may be compromised in high

4 4 DORSEge Lot frequency for some audience members)
5 5 As Needed

6 6 As Needed

7 7 n/a Not available in rep system

: o oot

Your show may also use up to two microphones. The vast majority of shows in Tawes do not use
microphones — they’re certainly not necessary for the audience to hear the actors. However,
there may be special effects in your show that live microphones can help you achieve.
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Load In

Adding Speakers to your System

The rep system is designed to allow 2 additional loudspeakers to be included your system
wherever you envision. Professor Larry Stahl can provide you with speakers and speaker cable
that you can use during load-in.

To install a speaker:

» Plug the speaker into the nearest speaker jack.

* In the booth patch bay labeled AVR-006, find the disconnected patch cable labeled “Add’l
17

» Connect this cable into the patch point corresponding to the speaker jack you plugged the
speaker into.

» Repeat this process with the disconnected patch cable labeled “Add’l 2” for your second
additional loudspeaker.

Adding Microphones to your System

The rep system is designed to allow 2 additional microphones to be included your system
wherever you envision. Professor Larry Stahl can provide you with microphones and mic cable
(XLR) that you can use during load-in.

To install a microphone:

* Plug the microphone into the nearest microphone jack.

* In the booth patch bay labeled AVR-005, find the disconnected patch cable labeled “Add’l
17

» Connect this cable into the patch point corresponding to the microphone jack you plugged the
microphone into.

» Repeat this process with the disconnected patch cable labeled “Add’l 2” for your second
additional microphone.

The first microphone will appear at the digital sound console on Channel 9. The second
microphone will appear at the console on Channel 10.

By default, both microphones are routed to the Upstage Left and Right loudspeakers.
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Preparing for the Start of Tech

Organizing Your Show on the Tawes Sound Laptop

As a reminder, you MAY NOT take either the Tawes Sound Laptop or the Tawes Sound Backup
drive out of the Tawes booth.
* DO NOT create your folder. or store ANYTHING related to vour show on the Tawes
Sound Backup drive. The Tawes Sound Backup drive performs automatic backups of
the computer, and should not be used for anything other than this.

» To begin your show, create a folder on the desktop with the name of your show.
*  Within that folder, I recommend creating two sub-folders to keep your show organized.

» Create a subfolder called “Audio” which contains all your audio files (mp3s, wavs,
etc.). If you find yourself having many drafts or versions of cues, it may be useful to
group them in sub-folders within “Audio”.

* For instance, Desktop / My Show Title / Audio / SQ 100 Preshow Music
could have many audio files for your pre-show playlist and Desktop / My
Show Title / Audio / SQ 105 TOS Music might have the different versions of
your top of show music that you have created.

* Create a subfolder called “QLab Bundles & Workspaces”. This is where you will
store your QLab workspaces on a daily basis. This folder structure keeps these files
separated from your audio.

* During strike of your show, you will move your entire show folder from the desktop itself to
the “Show Archive” folder on the desktop.

Creating a New QLab Workspace on the Tawes Sound Laptop

We have set up a template with some useful starting places for your new show.

To use this template:

* Open QLab by clicking the QLab icon on the dock.

» At the top of the screen, click File / New From Template.

* Click “Tawes Default” followed by “Select” in the bottom right corner of the window.

New document from template

QLab | i3 Edit Cues Tools View

New Workspace &EN
New From Template 43N

Open Workspace... $¥0
Open Recent >
Close $BW
Save &S
Save As... 1+ 88S

Save As Template
Bundle Workspace...
Revert to Saved
Manage Templates ﬂ
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Moving an existing QLab Workspace to the Tawes Sound Laptop

If you have already started work on your show elsewhere, at some point you’ll need to move it to
the Tawes Sound Laptop.

To do so,

PREPARE YOUR QLAB WORKSPACE ON YOUR EXISTING COMPUTER:

* Open your QLab Workspace on the computer you’ve been using.

+ At the top of the screen, click File / Bundle Workspace.

» This process will create a QLab Bundle, which keeps the QLab workspace together
with all of its associated audio in such a way that all references are preserved. (In
other words, QLab will know where your audio is when it’s looking for it.)

* Navigate to a place where you’d like your QLab Bundle to be located on your computer
(perhaps this computer has a “Show Name / QLab Bundles & Workspaces” folder of its
own). In the “Bundle As” field, I’"d recommend adding the date followed by the word
“Bundle”. For instance: “My Show 10.18.15 Bundle”.

* Press Save.

TRANSFER YOUR QLAB WORKSPACE TO THE TAWES SOUND LAPTOP

The fastest way to transfer your show to the Tawes Sound Laptop is using a flash drive. If you
don’t have a flash drive available, look in the section labeled “Transferring Files to the Tawes
Sound Laptop” below.

* Insert your flash drive into the computer that contains your QLab Bundle. Navigate to your
QLab Bundle and drag the entire folder (“My Show 10.18.15 Bundle”) onto the flash drive.

* Eject the flash drive.

* Insert your flash drive into the Tawes Sound Laptop.

*  On the Tawes Sound Laptop, find your QLab Bundle (“My Show 10.18.15 Bundle”’) on your
flash drive, and drag it into the Tawes Sound Laptop folder located at Desktop / My Show
Title / QLab Bundles & Workspaces

* Navigate to your QLab Workspace within the folder located at Desktop / My Show Title /
QLab Bundles & Workspaces / My Show 10.18.15 Bundle. Double click the QLab
workspace within this folder to open it in QLab.

ADJUST YOUR QLAB WORKSPACE TO WORK ON THE TAWES SOUND LAPTOP
Because your QLab Workspace was started on a different computer, there are certain settings that
need to be adjusted to that it works nicely on the Tawes Sound Laptop. When you’re finished,
you’ll want to Save As to move your workspace out of the folder it was Bundled in.

»  With your QLab Workspace open in QLab, go to Workspace Settings by clicking the cog icon
in the bottom right corner of the QLab window (or use the keyboard shortcut Command-
comma).
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Click “Audio” on the left hand side. Next to "Audio Patch 17, select Scarlett 18120 USB from
the drop-down menu so that QLab sends audio to the correct device.
* Itis also recommended that you change the Minimum Volume Limit (on the right
side of the screen) to -80 dB, and that you change the “Default Level for new Audio
Cues” master fader to -20 dB (on the left side of the middle section of the screen).

General

Key Map
OSC Controls
MIDI Controls
Audio

Mic

Video
Camera
Titles

Fade

0sC

MIDI

MIDI File

Timecode

—_
-o—ﬂ
o=

Group
Wait
Script

®
i
O]
]
X

For currently visible settings:

Audio Patch 1:
Audio Patch 2:
Audio Patch 3:
Audio Patch 4:
Audio Patch 5:
Audio Patch 6:
Audio Patch 7:
Audio Patch 8:

Scarlett 18i20 USB
(no device)
(no device)
(no device)
(no device)
(no device)
(no device)

(no device)

Default Levels for new Audio Cues

-20 0

master il

0
2

inputs crosspoints

0 0

Reset to Defaults

Settings for: Untitled Workspace 1

Edit Patch 1 Volume Limits

Max: +12 dB

Set All Default Set All Silent Assign Gangs

It is also recommended that you make some adjustments in the General page of the

workspace settings (click “General” on the left hand side):

* Change the “Minimum Time Required Between Each Go” to 0.3 seconds, so that if
your sound board operator presses the space bar twice quickly by accident, it doesn’t

fire two cues.

* Un-check the “Auto-number new cues with increment” check box so that you can
number your own cues as you work.
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* Make sure the “Lock playback position to selection” check box is checked to avoid
confusion, unless you are confident in your ability to work without it. (If you don’t
know what this refers to, leave it checked or things can get confusing very quickly!)

General

Key Map
OSC Controls
MIDI Controls
Audio

Mic

Video
Camera
Titles

Fade

0scC

MIDI

MIDI File
Timecode
Group

Wait

Script

ke
)
©
o
pT4

For currently visible settings:

- Settings for: Tawes Default.cues

When workspace opens, start cue number:

Minimum time required between each GO: O.3| seconds

¥ Also require a "key up" before re-arming GO

Auto-number new cues with increment:

Enable auto-load for new cues

¥ Lock playback position to selection

Panic duration: 1 second

Display size of cue rows: .
Small Medium

| Reset to Defaults | Done

¢ C(Click “Done”.

* In your QLab workspace, go to File / Save As, and navigate to Desktop / My Show Title /
QLab Bundles & Workspaces. Store your show in this location with a name that includes the
date. This step ensures that your QLab Workspaces will be in the QLab Bundles &
Workspaces folder, instead of in the sub-folder your bundle was transferred in.

Starting a New Console File for your Show

Some shows will be fine using the Tawes Rep preset on the digital sound console. If you think
you might make any changes to the sound console (especially if you are using microphones in
your show, as they are mostly excluded from the Rep preset scene), you can create a new “scene”
or show file for yourself prior to getting started.
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On the digital sound console, press “User Defined Key #1” on the bottom right hand side of
the sound console. This recalls the Tawes Rep Preset scene.

On the sound console, find the group of four buttons labeled “scene memory”. This is
directly to the right of the main screen on the sound console, level with the top of the screen.
Within the “scene memory” section, press the button with the up arrow until the top of the
screen shows a scene that is not used by a previous show.

Press the “store” button in the “scene memory section”.

Use the four buttons in the section below “scene memory” and the “enter” button to name
your scene. Press Store.

Note that now User Defined Key #1 will no longer recall your scene. You should make sure
your sound board operator knows that every day, they must navigate to your show’s scene by
using the arrow buttons in the “scene memory” section and pressing “Recall” once your
show’s scene name is flashing.

SCENE MEMORY

STORE

=
i
=

SELECTED CHANNEL
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The Tech Process

General Recommendations for Tech

During tech, the designer typically works at a table situated in the theater, where the audience
will sit during performances.

* The Tawes Sound Laptop remains in the booth (remember, the Tawes Sound Laptop
should NEVER be removed from the booth!)

* The designer typically works at their personal laptop, editing cues, or finding
existing content as necessary. Once a cue is ready, it is transferred to the Tawes
Sound Laptop, where it is integrated into the QLab workspace with the rest of the
show.

As your show may change rapidly during tech, it is a good idea to save new versions of the
show as you work. This way, you can easily return to an older version of the show, or
reference a previous version that you may have moved away from.

* Every day you work, begin by opening your QLab workspace and pressing Save As.
Within the Desktop / My Show Title / QLab Bundles & Workspaces Folder, save
your show with that day’s date appended to the end. As you go through the tech
process, this folder should have a QLab file for each day you were in tech.

Please remember to save your work often! Computers fail in a variety of different ways,
often without warning!

Controlling the Tawes Sound Laptop from Your Computer

During tech, you will be in the audience, and your show will be running on the Tawes Sound
Laptop in the booth. You can “screen share” to make changes to the show computer from your
laptop in the audience.

From a Mac:

Connect to the Tawes Sound wifi network with the password tawessound

Open the Finder. In the sidebar on the left, click on “Tawes Sound Laptop”, and then “Share
Screen”.

In the popup window, select “by asking for permission”.

On the Tawes Sound laptop, approve the request by clicking “Share Screen”.

From a PC:

Download “VNC Viewer for Windows” .exe version. Save this file to your desktop.
Connect to the Tawes Sound wifi network with the password tawessound
Double click on your VNC Viewer .exe file, and in the “VNC Server” box, enter:
192.168.1.144 (password: sound).
» If your connection is rejected, go to the VNC options and uncheck the box for
“Adapt to network speed.”
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Transferring Files to the Tawes Sound Laptop

During tech, you may be creating or finding audio on your own laptop, and want to incorporate it
into your show. You may do this by using a flash drive, or you can transfer the files over WiFi.

To transfer files over WiFi:
*  Connect to the Tawes Sound wifi network with the password tawessound
* Open the Finder. In the sidebar on the left, click on “Tawes Sound Laptop”.
* Double click Tawes Sound.
* Double click Public.
» At the top of the screen, click File / New Finder Window (or use the keyboard shortcut
Command-N) to create a new finder window.
* In this finder window, navigate to the content you want to transfer to the Tawes
Sound Laptop.
* Drag the audio into the Tawes Sound Laptop drop box folder.
*  On your computer, go to the screen share application (follow instructions in “Controlling the
Tawes Laptop from Your Computer”)
* In a new finder window, select the Tawes Sound user folder on the sidebar on the left. Double
click Public, and double click Drop Box.
* Drag the audio from the Drop Box folder on the Tawes Sound Laptop into the folder located
at Desktop / My Show Title / Audio.
* From here, you can drag the audio into your QLab session.

Operating QLab from the iPad

The Department of Theatre & Dance owns an iPad for production use. This iPad may not leave
the Tawes Theatre, though you may bring it between the booth and the audience.

The iPad is stored in the drawer in the Wall-Mounted Power Rack. Please return the iPad to this
location.

To connect to your show on the iPad:

* Open the Settings app on the iPad.

*  Choose WiFi.

* Connect to Tawes Sound (the password is tawessound)
* Return to the iPad home screen.

*  Open the QLab Remote App.
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Updating Your Show File on the Sound Console

If you find yourself making adjustments to the sound console during tech (especially if you are
using microphones in your show), you will want to store them as a “scene” (or perhaps more
than one scene — you may have one scene that turns a microphone on and another scene that
turns the microphone off).

For some shows this might not be necessary. The Tawes Rep preset scene doesn’t need to be
adjusted for a show that only uses QLab, or one in which the sound board operator is performing
any additional operations manually.

* Ifyou haven’t set up a scene for your show separate from the Tawes Rep Preset, follow the
instructions in this guide under “Preparing For the Start of Tech” in the section entitled
“Starting a New Console File for your Show”.

* As you work on your show during tech, you can store (save) your scene(s) by using the
“store” button in the “Scene Memory” section, and recall (load) your scene(s) using the recall
button.
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Working in QLab

QLab Overview

The QLab Documentation website (http://figure53.com/qlab/docs/) provides video tutorials and
explanations for a good amount of the software’s functionality. A google search will turn up
many answers to other questions you may have about QLab.

A useful template has been set up to get you started on every new show. Follow the instructions
in the section of this guide entitled “Creating a new QLab Workspace on the Tawes Sound
Laptop™.

QLab is the software that is used to run sound for all of our Theatre productions. It occupies the
place in the system that iTunes or a CD player would otherwise serve. However, QLab is the
industry standard. Unlike iTunes, QLab allows multiple audio files to play at the same time (or
ovelapping), with precise timing between the audio files; the designer can specify different
volumes for the different speakers in the system on a per-cue basis; and all of this can change as
needed through a series of fades.

QLab is a “cue-based” environment. Unlike a film, which proceeds on a fixed timeline, theatre
requires a flexible timeline, and to do so, a designer must break the sound-score down into a
series of “cues”, each fired on a series of successive “GO” commands. Perhaps on the first GO,
your audio starts playing and fades from imperceptible to quiet in a fixed amount of time. On a
specific actor’s line, the stage manager calls the next cue — GO — and the volume of the music
builds and shifts from stage left to stage right. A few moments before the end of the scene, the
next cue is called — GO — and the music builds to a climax. At the last word of the scene, the
stage manager’s GO fires a cue that syncs a loud percussive gesture with an abrupt fade out of
the music.

Configuring Your View in QlLab

There are a variety of windows and tools you’ll want to see and have handy while you work in
QLab.

On the left side of the screen is your Toolbox. (If it’s not visible, go to the View menu at the top
of the screen and choose Toolbox). You can drag cues from this toolbox into your cue stack to
build cues quickly. Also, you can drag cue types within the toolbox to re-order them. This allows
you to take advantage of the keyboard shortcuts printed to their right for working quickly.

The bottom half of the screen is the Inspector. (If it’s not visible, go to the View menu at the top
of the screen and choose Inspector). This section has multiple tabs (which are different for
different cue types), that allow you to control what specifically the cue does when it is fired.
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NOTE: Depending on the size of your window, it’s easy to lose track of some functions in the
Inspector. Make sure to scroll down in the inspector if something seems to be missing.

Above your cue stack is the Load to Time slider. (If it’s not visible, go to the Tools menu at the
top of the screen and choose Load To Time). This allows you to navigate through the cue you’re
standing-by for, which can be helpful during tech to skip through long sequences.

e 00 - Tawes Default.cues - Main Cue List e

m Speaker Check 8 Chan.wav

Load to time: (0:60 q

g’ Group 20 Number Q Target Pre Wait > Action > PostWait > &
<) Audio %1 } o ) Speaker Check 8 Ch... € 00:00.00 00:00.00 00:00.00

¢ Mic 82

B vide 3

B¢« Camera #4

T Titles 85

Basics Time & Loops Device & Levels Audio Effects

Audio Output Patch

1 - (no device)

Default Levels Set All Silent

- 20 0 0 0 0 0 0
- Visible
Assign Gangs  cpapneis: 10 master USL USR DSL DSR Addl Addl 7

1 2
inputs crosspoints

0 0
0

0
0

!g: !! Show 1 cue in 1 list A

iii
&

Basic Operations in QLab

In QLab, the space bar fires the next cue (or sequence of cues). This can also be performed with
the mouse by clicking the large “GQO” button.

The Esc key performs an action referred to as “panic”. This fades out all audio in 1 second and
stops everything. This is the cleanest way of stopping audio, either in tech or if there is an
emergency during performance and the show needs to be stopped.

If you need to stop your show more immediately, pressing Esc twice in a row will stop
everything immediately.
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Notice the white arrow-head to the left of your cue-stack. This is
called the “playhead” or “playback cursor”. As you fire cues
through your show, the playhead moves down your cue stack,
showing you what cue you’re standing by for — it points to the cue
that is “on deck”. A GO command fires the next cue and moves the
playback cursor to its next position.

To move through a sequence (fast-forward or rewind) during tech, or as you are working, click
on the cue you want to move through, and pull the gray ball along the Load to Time slider.
When you press the spacebar (or GO), it will play from the time you’ve selected.

When building or editing your show, double click under the Number, Q, Pre-Wait, Action (for
fade cues only), or Post-Wait columns to edit the cue number, name, or any of the durations in
the final three columns. Each of these operations also has keyboard shortcuts to speed up the
programming process. They can be found in Workspace Settings (the cog at the bottom right of
the screen), under Key Map.

Troubleshooting: if something isn’t working correctly, a large red X will appear next to the cue.
If you hold your mouse over that red X for a few seconds, a pop-up will tell you what has gone
wrong.

Creating an Audio Cue

To create an audio cue in QLab:

* Locate the audio file you want to play in Finder on the computer.

* Drag the file into QLab and drop it in the desired order in your cue stack.

* Give the cue a number and an appropriate name by double clicking in the “Number” and “Q”
columns, typing in a value and pressing Enter.

Basics Time & Loops Device & Levels Audio Effects
Audio Output Patch
1 - Built-in Output
Default Levels Set All Silent

-13.1 -196 -32 -123 -188

= Visible
Assign Gangs . 10 master  USL USR DSL DSR Addl Add"

inputs crosspoints
0 0
0
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In the Inspector window’s Device & Levels tab, use the master fader (for overall cue
volume) and output faders (corresponding to the volume of each individual loudspeaker in
the system) to adjust the levels of the cue.

If you want to adjust where the cue is routed (i.e. what speaker(s) it is playing out of), you
can do so in the Inspector window’s Device & Levels tab as well. In the section labeled
Crosspoints, you can type in the level at which the audio is sent to each loudspeaker /
output. Each column corresponds to a different loudspeaker. Click in a box and type 0 Enter
to send your audio to that loudspeaker at 0 dB.

Creating a Fade Cue

The Fade Cue in QLab is used to change parameters in an audio cue over a period of time. It can
be used to fade audio “in” (fading from a lower volume to a higher volume), to fade audio

“out” (from a higher volume to a lower volume), or to move audio between loudspeakers (fading
down in one loudspeaker and up in another).

© 0 0 Untitled Workspace 1 - Main Cue List

m 10 - Top of show music

Load to time: 00:00 ® Done

1 Cue List

Number Q Target Pre Wait > Action > PostWait > §

0
¥ Mic 82 " PP 10 Top of show m... l 01:09.00 Main Cue List

B Video SE th Fade in music 10 00:00.00  00:05.00  00:00.00
M« Camera 84

T Titles 85
4 Fade 86
© 0sc ®7 + Add New List

Basics

Absolute Fade

Stop target when done:

Set from Target Set All Silent

Assign Gangs

inputs  crosspoints

2 cues in 1 list

Drag a fade cue from the Toolbox into the appropriate place in your cue stack (or use the
keyboard command printed next to the fade cue).

Drag the audio cue you want the fade to operate on onto the fade cue and drop it. Now, the
fade cue “knows” what cue it is supposed to “target”.

Give the fade cue a number (if appropriate) and a name by double-clicking in the Number
and Q columns.
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* The fade cue’s parameters in the “Levels” tab of the Inspector determine what levels the fade
will finish at. You can fade the master level, individual output master levels, or any of the
crosspoints, by clicking on any of them and making an adjustment. A yellow item indicates
that it is fading in that cue. A gray item indicates that it is inactive in that cue.

* To change the duration of the fade cue (perhaps you want to make it fade over a longer or
shorter period of time than the 5 second default), double click in the “Action” column and
type in a new number and press Enter.

* You can also change the “shape” of the fade curve in the Curve Shape tab of the inspector to
adjust the specific trajectory of the fade.

» Ifyour cue is supposed to fade out the audio, in
addition to bringing the master volume to an
inaudible level, you may want the fade cue to stop Absolute Fade
the silent audio from continuing to run in the Stop target when done: ¥
background. To do this, check the “Stop Target
When Done” checkbox in the Levels tab of the
Inspector.

Set from Target Set All Silent

Assign Gangs

master

Connecting Cues to One Another

By default, every individual row in the Cue Stack needs to be triggered separately. If you want to
connect two or more rows so that they fire on a single GO, as part of a more complicated
sequence, click the empty space to the right of the “post-wait” column. The keyboard shortcut for
this is the letter C.

Pre Wait ) Action > Post Wait )
00:00.00 00:00.00 00:00.00

Pre Wait ) Action ) PostWait > ¢

00:00.00 00:00.00 00:00."" s
00:05.00

00:05.00
AUTO-CONTINUE AUTO-FOLLOW

The first time you click this area, an arrow will appear. This mode is called “Auto-Continue”.
The first cue plays and continues directly to the next item in the cue stack. The timing between
cues can be adjusted by entering a value in the “Post-Wait” column of the first cue (this is the
time after the first cue plays before moving on to the next item in the sequence), or equivalently,
in the “Pre-Wait” column of the second cue (this is the time after the second cue is fired before
it begins its action).

If you click the auto-continue arrow, the icon changes to a different mode, called “Auto-Follow”.
In this mode, the first cue completes its action and the next cue follows immediately thereafter.
Note that if you make an Auto-Continue with a post-wait equivalent to the duration of the first
cue, this mimics the behavior of an Auto-Follow.



Page 17

Adjusting the Integrated Fade Envelope

For some applications, instead of adjusting the volume of an Audio Cue through a series of Fade
Cues, it may be preferable to adjust the volume on the audio cue itself. You can do this using the

“Integrated Fade Envelope”.

* Click the audio cue you want to adjust.

*  Open the “Time & Loops” tab in the Inspector.

* To the right of the waveform view is a small button that turns the integrated fade envelope
on.

* Click on the yellow line to add a fade point.

* Drag the points to shape your integrated fade envelope.

-13 dB @ 05:06G.5™ N‘} >

Rate: 1

v Pitch shift

Adjusting a Cue’s Start or End Time

If you have an audio file whose start or end time you’d like to adjust, you can drag the yellow
vertical bars from the edges of the waveform in the “Time & L.oops” tab in the Inspector by
clicking on the gray arrows at the top of the vertical bars.

Time & Loops

Start time: 00:47.800 e >

End time: 01:43.148 Rate: 1

Play count: 1 ¥ pitch shift

Infinite loop
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Alternately, you can type numerical values into the “Start Time” and “End Time” fields.

Looping Audio

You can loop an entire audio file by typing a number other than 1 into the “Play Count” field in
the “Time & Loops” tab in the Inspector, or by clicking “Infinite L.oop™.

If you want to loop smaller sections of audio rather than the entire audio file, you can do so by
splitting the audio into “Slices”.

To loop your audio using slices:

*  Open the “Time & Loops” tab in the Inspector for the audio cue you want to slice.

* Click in the waveform where you’d like to add a “Slice Point” — the start or end of a region
you’d like to loop.

* Press “Add Slice”.

* You can move slices by grabbing their green arrows at the top of the waveform view.

* The number at the bottom of each slice region indicates the “Play Count” for that region.
Double click its Play Count and type a new number followed by Enter to adjust the number
of times a region will loop or play.

* Ifyou delete a Play Count number, it will change to an infinity sign, and that region will loop
indefinitely.

Time & Loops

Start time 00:00.000

End time 05:01.417 Rate

¢ pitch shift

This audio has been sliced.
Each slice has a loop count.
Drag slices out to delete them.

Delete All Add Slice

Show | 1 cue in 1 list
| Edit | J - Ee)
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Strike

Archiving Your Show (and Cleaning Up the Show Computer)

Once your show is closed, create a final QLab Bundle of your show:

*  Open your QLab Workspace

» At the top of the screen, click File / Bundle Workspace.

» This process will create a QLab Bundle, which keeps the QLab workspace together
with all of its associated audio in such a way that all references are preserved. (In
other words, QLab will know where your audio is when it’s looking for it.)

* Navigate to Desktop / My Show Title / QLab Bundles & Workspaces. In the “Bundle As”
field, I"d recommend adding the date followed by the word “Bundle”. For instance: “My
Show 10.18.15 Bundle”.

* Press Save.

On the Tawes Sound Laptop, find your show’s folder on the Desktop. Drag this folder into the
“Show Archive” folder on the desktop.

You may also want to transfer your show folder, or at least your final QLab Bundle onto your
personal computer using a flash drive.

Restoring the Rep Plot

If you added microphones or loudspeakers to the rep plot, please return them to Prof. Larry
Stahl.

Unpatch any loudspeakers you added by disconnecting ONLY the end of the patch cable labeled

“Add’l 17 or “Add’1 2”. DO NOT unplug the ends labeled “Rep! Don’t Touch!” Hang the
loose ends back up on the top of the rack labeled AVR-006.

Unpatch any microphones you added by disconnecting ONLY the end of the patch cable labeled

“Add’l 17 or “Add’1 2”. DO NOT unplug the ends labeled “Rep! Don’t Touch!” Hang the
loose ends back up on the top of the rack labeled AVR-005.
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Appendix: Additional Paperwork



